MS VS Express 2008 C++ A1 Visual C++ 1

Quick Introduction

The following pages provide a quick tutorial on
using Microsoft Visual Studio Express 2008 C++ to
produce a small project.

The following discussion is based on an actual session using the Visual C++ Studio
Express 2008. The menu selections and options illustrated here do not conform to
earlier versions of Visual C++.

A student may choose to use another existing ANSI standard C++ compiler/IDE if
they wish. However, it is the student's responsibility to ensure that their programs
compile and run under the Microsoft Visual Studio 2008 Express C++
environment. TAs will only be supporting the Microsoft Visual Studio 2008
Express C++ IDE. This means that students who choose to use other compilers
cannot expect the TAs to help them with specific compiler problems, (e.g.,
interface questions, compiler messages, warnings or errors). Instructors and TAs
will be prepared to help students that use the required compiler. Students that use
another compiler do so at their own risk.
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Getting Started: MS Visual C++ A1 Visual C++ 2

To start Microsoft Visual C++, click on , #Star]

select Programs > Visual C++ 9.0 Express Edition > Microsoft Visual
C++ 2008 Express Edition. (The first time you execute TR

it would will get the Window at the right.) W B e
You should now see a screen that looks similar to this:

[ [ | 1]
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File Edit View Tools Window Help
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Solution Explorer Start Page - X
' 1§i Microsoft® =
—+ Visual C++2008

R 7 Express Edition

| Recent projects || SethewswomMicrosort |

Download the latest information for developers to the Start Pa

Click here to enable an RSS feed that provides regularly updated articles
about new technologies, product tips and tricks, and upcoming events., Tr—
live feed also indudes information about service packs, community
technology previews, and Beta releases of Microsoft products and
technologies. To view the Microsoft Privacy Policy, go to

Tools/Options Environment/Help/Online and then dick Read the privacy
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Creating a Project

A1 Visual C++ 3

Before you can begin coding, you must create a new project.

To do so, go to the File menu and select New » Project.... (or click on the New Project button
below the file menu). You should see a dialog similar to the one below. Note that the Location of the
project will be where a new directory is automatically created to hold all of the files for the project.
Be sure to select Win32 project type and the correct project template: Win32 Console Project:

MNew Project

Project types:

Templates:

= 'u'i_sual C++

Visual Studio installed templates

Win32 Console Application
/| Win32 Project

My Templates

4 Search Online Templates. ..

A project for creating a Win32 console application

Mame:
Location:

Solution Name:

I DayOfiesk

I C:\Documents and Settingscoecomps. COETAB 1My Documents\CoursesiCS 1044 j Browse... |

I DayOfieek

¥ Create directory for solution

o]

Cancel |
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Project Wizard A1 Visual C++ 4

After clicking Ok from the New project dialog window you will be presented
with the project creation wizard “Win32 Console Application” dialog window as
shown below. Click on Application settings & confirm the settings as depicted

below then click Finish. 2]
_— Application Settings
Crveryie Application type: Add common header files for:
&pplication Settings " Windows application o
% Console application ™ mrc
£ DLL

{ Static library
Additional options:

¥ Empty project

I | Export symbols

Precompiled header
ecompiled heade

< Previous Mext = Finish Cancel
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N Project View A1 Visual C++ 5

If you selected Win32 Console Application (this will create an application that runs at the command
prompt [like DOS]). In the Project Name text field, if you named your project DayOfWeek. In the
Location text field, you typed the directory in which you wished to store your code files. After
clicking OK, Close the Start Page within MS Visual Studio and select VView menu / Solution
Explorer, you should see a screen that looks similar to this:

=l

File Edit View Project Build Debug Tools Window Help

iG-S e % BB -~ - &-E| b Debu - Win32 -

&

Koo l&{. Jdaaojdx g aszqzmuﬁ!: !' -

Solution Explorer - DayOfiveek ~ & X

@5

D Solution 'Day0fweek’ (1 project)
& D |

[ Header Files

- [ Resource Files

e [ Source Files

If you don’t see the
Solution Explorer
pane, pull down
the View menu &
select Solution

@Soluti... |@Class... IEIPrope |

Code Definition Window X EX p I 0 re r .
No definition selected =
| | |
ECode Definition Window :EI Call Browser IE Cutput |
Creating project 'DayOfWeek'... project creation successful. 4
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Creating a Code File A1 Visual C++ 6

Now that you have created a Project, you can add source code to it. To do so, go to the Project menu,
select Add New Item...You should see the following: Select Code / C++ File, enter DayOfWeek for
the name and click on Add to continue.

Add New Item - DayOfWeek ilil
B [oeo
Categories: Templates: aE
&= Visual C++ Visual Studio installed templates

Ul

- Code ] C++File (.cpp) 1] Header File (.h)

. Property Sheets ] Component Class

My Templates

Search Online Templates. ..

Creates a file containing C++ source code

Mame: I DayOfieek

Location: I c:'\Documents and Settings\coecomps, COETAB 1My DocumentsCourses\CS 10449 DayOfineck\De Browse... |

Add Cancel |
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Creating a Code File (continued) A1 Visual C++ 7

Project + Source Code File:

You should now see a screen that looks similar to this:

B payOfweek - Visual C++ 2008 Express Edition -0l x|
Fle Edit View Project Buld Debug Window  Help
G- E- S d % 2@ 9™ - F-F | » pebug v Win32 - | & R
BRbLae|EE =2 0P335 R,
Solution Explorer - Solution*... + & X DayOfWeek.cpp - M T‘l
= -
| &= {Global Scope) =l =i =
[ Solution DayOfiveek’ (1 project) ||
=~ (24 DayofWeek | H |
- [[1 Header Files g‘
- [1 Resource Files g
= E Source Files 15|
b €+ DayOfeek.cpp oo
g_'
o
EN
g soluti... |@CI355... |EPrope... | 4| | 3
Code Definition Window X
Ho definition selected - |
4| | 3
ECode Definition Window '}EICaII Browser |E| Output |
Ready Ln 1 Col 1 chi INS v
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Sample Code A1 Visual C++ 8

Day of Week Program

Now in the edit window that just appeared type in the following C++ source code:

#include <iostream>
#include <cstdlib>

using namespace std;

int main() //Find the Day of the Week for a Date
{

int mon, day, year;

cout << "Enter a date for which you wish to know" << endl;
cout << ""the day of the week (MM DD YYYY)? ";
cin << month >> day >> year;

iIT (year < 1752)
cout << "Only Gregorian dates accepted, sorry " << endl;
else {

iIf (month < 3) { //Jan & Feb = 13 & 14 preceding year
month += 12;
year -=1;

{ // end if
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Sample Code (continued) A1 Visual C++ 9

Day of Week Program

WeekDay = (day + 2*month + 3*(m0nth+1)/5 + year +
year/4 - year/100 + year/400 + 1) % 7;

1T (month > 12) { //reset Jan & Feb
month -= 12;
year += 1 ;

} 7/ end if

cout << month << "/" < day << "/" << year << " falls on ";
switch (weekday) {

case 0: cout << "Sunday" << endl; break;

case 1: cout << "Monday" << endl; break;

case 2: cout << "Tuesday" << endl; break;
case 3: cout << "Wednesday' << endl; break;
case 4: cout << "Thursday" << endl; break;
case 5: cout << "Friday" << endl; break;
case 6: cout << "Saturday" << endl; break;

} // end switch
} /7 end else

return EXIT_SUCCESS;
} // end main

Computer Science Dept Va Tech August, 2008 Intro Programming in C++ ©2008 Barnette ND & McQuain WD



Code Window
Code Entry

A1 Visual C++ 10

Now that you have entered all of your source code, you should have a window that looks like:

B DayOfweek - Visual C++ 2008 Express Edition

File  Edit Project Build Debug Tools Window Help
EEE'E]'E'H@|*'={£ES|""[‘"'__ji;lbDebug
S22 0PBaBEER,
-~ 3 X Day0OfWeek.cpp™

View

+ Win32

- |

iE

=10l x|

&
E:

cout << "Enter a date for which vou wish to know™ << endl;
cout << "the day of the week (MM DD YYYY)? ";
cin << month >> day >> year;
if (wvear < 1752)

cout <<

aloo §

"Only Gregorian dates accepted, sorry " << endl;

@Soluﬁ... |@C|ass... |EPrope... |

e | i g
| '3 | =l (Global Scope) j I i main{) j E—
|: Solution 'DayOfweek’ (1 project) - - —l|lg
B IEH DayOfWeek H #include <iostream>» m Ik
" [ Header Fies #include <cstdlib> g

i [ Resource Files g
=1 [£5 Source Files using namespace std; il
i ©] DayOfieek.cpp I e

int main{) //Find the Day of the Week for a Date =

: ¢
int mon, day, vear: E=

Code Definition Window
Ho definition selected

4]

When you are done, save the
file (<Ctrl S> or File, Save)

HE

ECode Definition Window :;.EICaII Browser |E| Output |

Ready Col 7

INS v
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Building an Executable

Compilation

A1 Visual C++ 11

You can now attempt to build your project. Building involves compiling and linking into an
executable. Attempt to build the project, by hitting F7 or from the Build menu, select Build Solution:

DayOfweek - Visual C++ 2008 Express Edition - ||:||5|
File Edit View Project Build Debug Tools Window Help

o~ b @[99 -0 -&-5| b Debu v Win32 - | & - REBERE
Z20PREBEBR,

X DayOfWeek.cpp - X

2 E (Global Scope) j I “wmain() -

[ Solution ‘DayOfeek’ (1 project) Ticioo - - —

- 33 DayOfWeek [0 #include <iostream> —

‘. [ Header Files #include <cstdlib>

- [ Resource Files

= [ Source Files using namespace std;

¢+ DayOfieek.cop

int main(} //Find the Day of the Week for a Date

{

int mon, day, year;

yvou wish to know" << endl;

| xapo L 3 |_|a_|u:||d><;| asEqEE] E-é'l

‘coecomps . coetabli\my documentshcourses\cslld4ddayofweekhdayofweek \dayofweek cpp(l8) : error C20e5:

cout << "the day of the week (MM DD ¥YY¥Y¥)? ";
= cin << month >> day >> year;
if (year < 1752)
cout <« "Only Gregorian dates accepted, sorry " << endl:;
else {
of]
ciSoluti... |'Q§CIass... IMEPrope... | 4| | 3
Cutput ~ 3 X
Show output from: Build - B @B x| F
ject: DayOfWeek, Configuration: Debug Win3z --———- =
cetablim umentsh c ealiddhyd eekida ek d : undeclared identifier

‘month’

undeclared identifier

Ready

“coecomps . coetablimy documentshcourseshcsliddrdayofweek\dayofweekhdayofweek_ cpp(ld) : error C2065: "month' : undeclared identifier
‘coecomps . coetabli\my documentshcourses\csllid4ddayofweekhdayofweek\dayofweek cpp(23) : error CZ2085: 'weekDay' : undeclared identifier -
Kl | J
4 Code Definition Window [*= Call Browser | =] Cutput |
Ln 4 Col 79 Ch 79 INS v
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Error Messages A1 Visual C++ 12

Finding Errors
Notice the compiler error messages in the lower window. Double click on an error message, and the

line with the error will be indicated in the code window:
RI=E

File Edit Wew Project Build Debug Tools Window Help

A-EH-EHdd | % BRR9 -8B b Debu = Win32 - | @ - | &3 5 E S B

Db |EE 2 0P AR5 R,
X

m

DayOfWeek.cpp™ - M I_Il'l‘l

Solution Explorer - Solution'... ~ &

ép El {Global Scope) jl'\imain{] ji §
'_a Solution ‘DayOfwesk' (1 project) - - =
E| E DayOfWeek [0 #include <iostream> / \
- #include <cstdlib> .
[ Header Files
| B Resource Fles _ If you did not
B l__"i Source Files using namespace std; format your text
o €+ DayOfWeek.cpp
:;.nt main() //Find the Dav of the Week for a Date similar to the
ine DR, day, vear: code at the left
cout << "Enter a date for which you wish to know" << endl; then the Ilne
cout << "the day of the week (MM DD YYYY)? ";
= cin << month >»> day >> year; numbers on the
_ error messages
if (year < 1732)
cout << "Only Gregorian dates accepted, sorry " << endl: may not matCh
else {
the ones shown.
) Soluti... |Z_7%Class... Ij_!lPrope... | 4| |

Show output from: Build - %}1 ‘-iej _:-.b = =
ject: DayDfWleek, Configuration: Debug Win3Z ———-——

‘coecomps.coetabl\my documentshcourseshcsliddi\dayoiveekidayociveekidayofveek. ) : error C2085: 'month' : undeclared identifier
“ocoecomps.coeteblimy documentshcourseshcosliddideyofweek \dayofveek\dayofveek. . cppi(ls) - : undeclered identifier
“coecomps . coetebli\my documentshcoursesi\cslli44\dayofweekhdayofweek\dayofweek_ cpp(1%3) : error CZ0685: "month' : undeclared identifier

'month’

“coecomps . coetebl\my documentshcoursesi\csli44\dayofweekhdayofweek\dayofweek cpp(23) : error CZ085: "weekDay' : undeclared identifier -

4 I

3 Code Definition Window [*=Call Browser | =] Output |

Ready Ln8 Col chg INS =

Computer Science Dept Va Tech August, 2008 Intro Programming in C++ ©2008 Barnette ND & McQuain WD



Error List

A1 Visual C++

Compilation Errors
Now correct the errors relating to each line and build the project again:

Error corrections:

In case you can't figure out the errors here they are:

Line 9:

Line 13:

Line 22:
Line 24:

Line 32

change mon to month

add the variable weekday
change the << to >>

(we want to save the value to a variable, not write it to the output stream)
change the { to } (we want to end the block, not start one)

change weekDay to weekday to match the declaration

change the < to <<

Continue correcting errors and rebuilding until you have no errors:

If you did not format your text similar to the code shown previously then the

line numbers on the error messages may not match the ones shown.

13
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Clean Compilation A1 Visual C++ 14

No Errors
ol x|

File Edit View Project Buld Debug Tools Window Help

A-E S @ %GB0 F-B| b ey - Win32 - | | REFBEXBR
H - Tl £ = ﬂ = E 'ﬂ
b B R‘_l Az —— |:| H‘:'] -!' L @ lﬂ} 4{&
20 Day0fWeek.cpp > x [in
[=1
(Global Scope) j I S main() j %
'__m Solution 'DayOfweek’ (1 praject) =3
= 5 DayOfweek ~fl|=
EDHeader Files weekday = (day + Z*month + 3% (month+1l)/5 + vear + ox
[ Resource Files year/4 - year/100 + year/400 + 1) % 7:;0 =
& B Source Files if (month > 12) { //reset Jan & Feb ER
i €] DayOfWesk.cpp month —-= 12; }§
year += 1 ; =
y S/ end if %
=

cout << month << "/" << day << "/" << year << " falls on ";
awitch (weekday) {
case 0: cout << "Sunday" << endl; break:

case 1: cout << "Monday"™ << endl; break;
case 2: cout << "Tuesday"™ << endl; break:;
case 3: cout << "Wednesday" << endl; break:
case 4: gcout << "Thursday" << endl; break;
case 5: cout << "Friday" << endl; break:
case 6:

cout << "Saturdayv" << endl:; break; i
>|

L‘:fgSquﬁ... |@Class... |L_::_3.‘Pro|:le... | 1| |

Show output from:  Build - _ﬂ "_.J N =%
1*Embedding manifest. . _ -

1¥Microsoft (R) Windows (R) BEesocurce Compiler Version €.0.5724.0

1>Copyright (C) Micreoscit Corporation. RAll rights reserved.
1>Build log was saved at "file://ec:\Documents and Settings'coecomps. COETRABIAMy DocumentshCourseshC51044%Day0fWeck' DayDiHeek Debugh Buils

1>, k e r{s), 0 warning(s)
Build: 1 succeeded, 0 failed, 0 up-to-date, 0 skipped

-
1| | LI_

||_:1Code Definiion Window :;EICaII Browser |E| Output |

Build succeeded Ln 12 Col 39 Ch 39 INS v
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Running a Program Al Visual C++ 15

Program Execution

Now that your code has been compiled into an executable, it is ready to be executed. You can do so
by pressing <Ctrl F5> or going to the Debug menu and selecting Start Without Debugging. Now you

should see a DOS prompt with the program running:

co (CYWINDOWS\system32 Y\ cmd.exe
Enter a date for which you wish to know
the day of the week (MM DD Y¥Y¥2>Y 6 20 1769

6201967 falls on Friday
Prezz any key to continue . . .
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